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Subject: Computer Science <40 Class: X
@ Q.1  Multiple Choice Questions:
(1) Speed of dot matrix printer is measured in............... W
Ans: a) cps
21 St Printer is used for fax machine. ; 37 o

Q.2

o

e

Ans: d)Thermal

(1ii)What can be attached to email as an attachment?
Ans: d)All of these

D B B R i i s bt b St o /
Ans: b) Network interface card '

(v)Which of the below is not a line spacing option? /
Ans: d) 2 Lines

(Vi)A letter that appears little below the normal text is called....................
Ans: b) Subscript /

e I /
Ans: ¢) ALT+F4

(viii)Formula should always start with............................. /

Ans: a)=

a)What is LED? Explain its two advantages.

Ans: LED: The Light emitting diode (LED) is a two-lead semjconductﬁht source.
In1962, Nick Holonyak has come up with an idea of light emitting diode, and hewas
working for the general electric company. The LED occupies the small area which is
less than the 1 mm?2. The applications of LEDs used to make various

electrical and electronic projects. Wmmng diode is a p-n junction diode. It is
a specially dopeddiode and made up ofa special type of semiconductors.

Advantages of LED: /
1. The cost of LED's is less and they are tiny:
2. By using the LED's the electricity is controlled. /

Or

Define OHP? Write the guidelines to handle the OHP.

Ans: Overhead Projector: An overhead projector isa machine that has a light inside
it and can be usedto make the writing or pictures on a sheet of plasticappear on a
screen or wall. The abbreviation OHP is also used. /‘
HANDLING OF OVERHEAD PROJECTORS:

1. Cover the transparency when you are done using it-with an opaque piece of
cardboard mount a solid sheet of paper on one of my transparency frames. You may
also turn off the projector completely, but beware, this can cause the projector bulb to
burn out sooner. -~




2. Bring a spare bulb. Bring spare bulbs and a glove to change the bulb. The old bulb
will be hot. Make sure you know how to change the bulb. Remember hot glass looks
the same as cold glass!3. Place the overhead to your right if you are right handed and —
to your left if you are left handed-This will make it easier for you to face your
audience and write if you need to. In either case, you want to stand in the center of
the speaking area and face the audience when you speak.

4. Place your overhead projector on a table low enough so it does not block -

you or the screen. Have a small table next to the overhead so you can stack your
overheads before and after you use them.

5. Tape the power chord to the floor-to protect you or someone else from tripping. As -
the presenter, tripping over the chord and falling, although humorous, is one large
gesture you would, prefer to avoid.

6. Store your overhead transparencies in a sturdy box or container so they will stay
clean and protected for the next time you need them. Label the box and include
“clean"” copy of your handouts in the box. 0)55\\}

b) What is FAX machine? Write the steps to send a fax.

Ans: Fax Machine: Fax machine device that sends and receives printed pages or
images over telephone lines by digitizing the material with an internal optical scanner
and transmitting the information as electronic signals. The transmissions it sends are
called "faxes," and these can be sent between two fax machine%?l;rfs:tween a fax
machine and computer or online fax that is equipped to send and receive faxes.

The steps in sending a fax are as follows:

1. Turn on the fax machine il

2. Insert your documents with face of documents up.

3. Dial the fax number where you want to qegd the fax

4. Press the "Send" button.

5. Wait for the document to finish transmlttmg./

Or

Describe laser printer. Explain its two advantages and two disadvantages.

Ans: Laser Printer: The print quality of these printers is very fine. They are more
expensive than other printers like dot matrix, inkjet etc. These are also known as page
printers because they print one page at a time. They produce images on paper
directing a laser beam at a mirror which bounces the beam on a drum.

Advantages of Laser Printers:

1. These printers have high printing speed and can print around 30 pages in one
minute. "

2. They are quiet while working and barely emits any sound.

Disadvantages of Laser Printers:

1. More expensive than inkjet printers.

2. Except for high end machines, laser printers are less capable of printing

vivid colors and high quality images such as photos. g

a) Define Local area network with its two disadvantages.

Ans: Local Area Network (LAN) is a network that is used for communicating /’
among computer devices, usually within an office building or home. It enables

the sharing of resources such as files or hardware devices that may be needed by
multiple users. It is limited in size, typically spanning a few hundred meters, g
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and not more than a mile. It is fast, with speeds from 10 MBPS to 10 GBPS.
Disadvantages:

1. Access to shared devices can be slow as compared to dedicated resource like

printing. /

2. A virus can spread more easily. /

b) How will you define web browser. Write its four examples.

Ans: A web browser is a software application for retrieving, presenting and
traversing information resources on the World Wide Web. The method of accessing a
particular page or content is achieved by entering its address known as a Uniform
Resource Locator or URL. This may be a web page, image ,Videomi piece of
content. Hyperlinks present in resources enable users easily to navigate their browsers
to related resources. A web browser can also be defined as an application software or
program designed to enable users to access, retrieve and view documents and other
resources on the internet.
Types of web browser:

1. Internet Explorer«

2. Google Chrome”
3. Opera Browser :
4. Mozilla Firefox ©

¢) How will you send and receive an email?
Ans: E mail:Its full form is electronic mail. It is widely used features of the internet
along with the web. It allows us to send and receive messages to and from anyone
with an e-mail address, anywhere in the world. Email uses mltiple protocols within
the TCP/IP suite. e.g., SMTP is used to send messages, while the POP or IMAP
protocols are used to retrieve messages from a mail server.

/

Sending an E-mail:

You proceed as below to send or receive an e-mail;

(1) Type URL (e.g. www.yahoo.com or www.rediff.com) of the website on internet
explorer after getting connected Wnternet.

(1) Click the button Go or press Enter Key.

(1i1) Click mail button. The mail window will be shown.

(iv) Then type mail Id and password. o

(v) Click sign in button.

For Sending E-mail follow the following steps:

1. Click on Write Mail (in rediff mail) or Compose (in yahoo).

2. Write Receiver's address in box.

3. Write Title of the main Subject.

4. Now write the content of the Mail and click on Send to send you mail.
Receiving an E-mail:

(1) Click on check mail button on yahoo mail webpage.

(2)Yahoo mail webpage will be seen as shown in the figure.

(3)Click on mail button and read the“message in the mail box.

Or
Differentiate between MAN and WAN.
Ans: The difference between MAN and WAN are as follow:




Q.4

G)

Sr. No | MAN WAN 5
1 MAN stands for Metropolitan | WAN stands for Wide Area
Area Network. Network.
2 May use Guided or Unguided | Uses Unguided media like Satellite
media communication, Radio
wave communication Micro Wave
communication etc
3 This  network  shares the | A communication network
characteristics of packet | distinguished from a Local
broadcasting networks. Area Network.
4 A MAN is optimized for a large | Its long distance communications,
geographical which may or may not
area than LAN. be provided by public packet 0
network.
5 Uses  moderately expensive | Uses expensive equipment
equipment
6 Propagation delay is moderate | WAN suffers from propagation
delays.
7 Error rates are moderate in | Error rates are high in WAN
MAN i

a) What will you do while you want to find and replace a text in MS- word?

Ans: Find and Replace:

When you work with longer documents, it is difficult and time consuming to locate a
specific word or plfase. Word can automatically search your document for specific
word or phrase using the Find feature. It also allows us to change words or phrases
using Replace.

Steps to find text:

Click on Home — Find—Navigation Pane

(1)Go to Home tab, clicktte Find command. The navigation pane will appearon the
left side of the screen.

(ii) Type the text you want to find in the field at the top of the navigation pane.

(1i1) If the text is found in the document, it will be highlighted in yellow and a
preview will appear in the navigation pane.

(iv) If the text appears more than once, you can click the arrows on the navigation
pane to step through the results. You can also click the result previews on the
navigation pane to jump to the location of a result in our document.

(v) When you close the navigation pane, the highlighting will disappear.

Steps to replace text thatmve already find:

()From the Home tab, click the Replace command. The Find and Replace dialog box
will appear.

(ii) Type the text you want to find in the Find what field.

S
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(i1i)Type the text you want to replace it with in the Replace with field.
(iv)Click Find Next and then replace to replace text. You can also click
replace all to replace all instances within the document.

b) Describe the term bullets and numbering. How will you assign bullets and
numbering in a document with the help of a diagram?

Ans: Bullets or numbers can be added quickly to existing lines of text, or Word

and can automatically create lists as we type. By default, if we start a paragraph with
an asterisk or a number.

Insert Bulleted or Numbered List: Click on the area where we would like our list to
appear or highlight the text we would like to be in a list.

Do the following steps:

(1)Go to the Home tab, in the Paragraph group, click Bullets or Numbering.
(i1)Bullets or numbers will be shown

(111)Now select the desired one.
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¢) How can you merge and split cells in MS-word?

Ans: Merging Cells:

You can also merge two or moi?ﬂs to make one cell to give it a betterlook. The
steps to merge cells are given below:

1. Select the cells you want to merge. Click the Layout tab.

2. Click on Merge Cells in the Merge ;J:eﬁp.
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3. The data gets combined in one cell.

Name Class Roll Na ' Section |
Vikas 1 33 P /

e

Fig. Before Merge Cells

asmee| 4 T

After .-1'1’!'!:.’{1' Cells

Splitting Cells:

You can split a cell into two or more cells. Perform the following steps to Split a
Cell:

1. Select the cell you want to split.

2. Click on Layout tab. /

3. Click on Split Cells button in the Merge group.

4. The Split Cells dialog box will appear on the screen.

5. Enter the number of rows and columns into which you want to split the selected
cell.

a) Define following:

i)Spreadsheet ii)Worksheet iii) Formula bar

Ans: i)Spreadsheet: A spreadsheet is a sheet of paper that shows accounting or other
data in rows and columns; a spreadsheet is also a computer application program th
simulates a physical spreadsheet by capturing, displaying, and manipulating data
arranged in rows and columns.

Worksheet: A Worksheet is a collection of cells organized in rows and columns.
Each worksheet contains 1048576 rows and 16384 columns and services as a giant
table that allows you to organize information. Typically, a workbook contains several
worksheets with related content and only one of the worksheets is active at a time 7

Formula Bar: In this bar the cell address of the active cell is displayed in the Name
box which is located on the left side of the Formula bar. Cell entries are displayed on
the right side of the Formula bar. In the other words Formula bar displays information
entered in the current or active cell. The contents of a cell can also be edited in the
Formula bar.

If formula bar is not displayed in the window then perform the following steps to
display the Formula bar in window: /P

1. Click on View tab.

2.Click on Formula Bar under Show/Hide Group.

Or

a) Define following functions:

x4
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1)SUM( ) i)AVG()
iv)MAN () 1111)MIN( )
v) If

(@ o\{'\ Ans: (i) SUM( ): The SUM function is the most commonly used excel function.

~" 77+ SUM function is used to add all the number in a range of cells. The syntax is
SUM (number 1, number 2.......... b
number 1, number 2.......... are 1 to 255 arguments for which you want to obtain the
sum or total value.

(1) AVG( ): This function returns the average of a list of arguments i.e. it is used to
calculate average of values in cells. The syntax is

AVERAGE (number 1, number 2,

e.g. AVERAGE (F6: F12) will calculate average of cells from F6 to F12.

(iii) MAX: This function returns the largest value in a set of values. The syntax is
MAX (number 1, number 2..........
e.g. MAX (F6:F12) will obtain the maximum value/f;'om F6 to F12

(iv) MIN: This function returns the minimum value in a set of values. The syntax isol
MIN (number 1, number 2, .......... )
MIN (F6: F12) will obtain the minimum value frorfi F6 to F12.

IF Function: IF function returns one value if a condition you specify evaluates to
TRUE and another value if it evaluates to FALSE. Use IF to conduct conditional tests
on values and formulas. The syntax is /

IF (logical test,value_if true,value_if false)

Q.5 b) Define Chart. How will you insert any two types of charts in MS-excel.
= Ans:Chart: A chaft is a tool in Excel that is used to represent data pictorially. A chart
E) /can allow us to know the meaning behind our data. We can use these charts to make
-~ comparisons much easier. You can use different types of charts to represent data.

1 Pie Chart
2.Comuln Chart ¢

1.Pie Chart: Pie charts can show a lot of information in a small amountof space.
They primarily show how_different values add up to a whole.To create Pie Chart,
follow the following steps:

i. Type data in MS Excel.

i1 Click on Insert — Pie chart option.

lii There are different types of Pie chart in drop down option.

iv Now select the entered data.

v The select any one pie chart from them.

vi The Pie chart will appear on the screen.

2. Column Chart:

Column Chart: A column chart i?/g{ph that shows vertical barswith the axis values
for the bare displayed on the left side of the graph. It is a graphical object used to
represent the data in your Excel spreadsheet. You canuse a column chart when you
want to compare values across categories.




To create Column Chart, follow the following steps:

i. Type data in MS Excel. /

ii. Click on Insert Column option.

iii. Now select the entered data..

iv Click on Column chart. There are different types of Column chart in the drop down
menu.

v Select any one Column chart from them. - o

vi. The Column chart will appear on the screen.

Or

How will you record a macro?

Ans: Macros are very useful,.where we want to repeat same steps repeatedly. A
macro is a series of comrfiands that is grouped together so that we can run Whenever
we need to perform the specific task. We can use macros in Excel to save time by
automating tasks that we perform frequently .Macro recorder is the easy way to create
many macros. When we record a macro Excel stores the information about each step
you take as you perform a series of commands. We than run the macro to repeat or
play back the set of commands. -~

Recording a macro: To record a Macro perform the following steps:

(1) Choose Record Macro in the Code group of the Developer tab. The Record Macro
dialog box appears.

(i1) Type a name for the macro An the Macro Name text box. First character of the
macro name must be a letter and the name cannot contain spaces or cell references.
Macro names are not case-sensitive.

(i1i) Assign a Shortcut Key to Macro: If you have already selected a shortcut key in
Excel, the macro shortcut key overrides the Excel shortcut key while the workbook
that contains the macro is operr. P

(iv) On the Store Macro In drop-down list, select where we want to store the macro

|
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